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JoomLA! ADVANCED CONTENT EDITING

GETTING STARTED

1. If you are working from home or another off-campus location, log on to the Rutgers VPN from your computer;
you can find instructions here:
e  https://sas-it.rutgers.edu/how-to-guides/working-remotely/vpn-instructions

2. Open a web browser on your computer (preferably Firefox, Chrome, or Safari)
3. Gotothewebsite: https://www.sas.rutgers.edu/cms/training

WHAT IS JOOMLA?

Joomla! is Content Management System (CMS) software that runs on a web server and allows you to update your web
site through a browser (such as Google Chrome, Mozilla Firefox, or Safari). A content management system simplifies the
process of updating a website by eliminating the need to edit HTML or use web design software.

Visit https://www.joomla.org/ for more information on Joomla.

For additional training visit:

https://community.joomla.org/joomla-training.html

For additional information and workshops visit:

https://joomlausersnj.com
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JOOMLA: FRONT-END AND BACK-END

A Joomla! website has a back end and a front end. The front end allows you to view the website, and make some basic
edits to the site (by clicking the Login link in the “Footer Menu” — see below). The Administrator Back-end gives you
much more control of the website.

ACCESSING THE BACK-END
Open a new browser window: Ctrl+N (Windows) or Command+N (Mac)

Then, enter the URL:

https://www.sas.rutgers.edu/cms/training/administrator/

Click Login Button

(Some of our older
websites have a slightly
different login display)

— Login with your NETID
e username and
p———————— S,_M password.

i S s, S s RUTGERS
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JOOMLA BACKEND INTERFACE

After you log in to the back end, you will see the Joomla! Control Panel:

System ~  Users ~

Control Panel

Read Messages

Laura Gordon Adminstration

Laura Gordon Administration

& users

NFIGURATION 7D Welcome to SAS CMS Training
© Gioval (@D Administrator Lesson #9: Changing Category Blog View Elements
@ T

@€ sandvox Administrator Interface Login

@D Administrator Lesson #12: Updating Documents using DocMan

Moving your web site to the SAS CMS system
. Install Extensions

B JCE File Browser
DEE

v Rutgers Electives Search Edde Konczal

«  Eddie Konczal Eddie Konczal

<

Chika Okoye Okoye, Chika

v Stella Khezri Khezr, Stetia

7 Traci Cole Cole, Trac

Top Menu

CMS Sandbox ... & ~

¥ loomlal

Preview Website (opens front-
end in new window)

B 20080522 09:53

B 2006-11-02 10:40

2006.01-05 0507

2006.01-05 0453

I

2006:01-1005:58

@ 20161205 16:00
B 201611281355
B 20161129 1854
= 11-29 13:54
= 129 13:54

REVIEW OF JOOMLA! TERMINOLOGY:

e (Categories are similar to folders. They can contain articles and sub-categories.

e Articles are similar to individual web pages.

e Menus are collections of links (called “menu items”) that allow visitors to browse the website.
e Modules are special blocks of content that can be placed outside the main article area.

Page




ARTICLES

An article is similar to a single web page within your website. An article can contain formatted text, images, embedded
video, and links to other articles or external web sites. You can organize your articles by saving them into the
appropriate categories.

CREATE NEW ARTICLE

Group Practice — CREATE ARTICLE:

1. Go to Content > Articles > Add New Article

2. Title: enter your name

3. Category: “Advanced Content Editing” (found under
“Workshops”)

4. Click Save & Close

How TO FIND ARTICLES

One of the challenges in editing a Joomla! website is how to find front-end content in the back-end. The key is to
determine which menu item brings you to the page you want to edit. Then, you can locate the menu item in the back
end to see which content it links to.

1. Identify the name of the menu item as it appears on the front end.
2. Inthe back-end, go to Menus > Main Menu
3. Change the selection number dropdown from 20 to 100 (or more, if necessary), so you can see all menu items

Users + Menus ~ Content + Components ~ Extensions » Help ~ CMS Training|. & X ~
- L]
ltems (Main Menu) ¥ Joomlal
- @ | Edit + | Publish @ | Unpublish b | Check-in % | Home ™ | Rebuild [m] | Batch m | Trash 0 | Options
@ | Hep
@®
Site - Main Menu - Search Q Search Tools »
Ordering ascending - 20 | -
* -~ [ Status Title Menu Home Access Language 1D
O v Home (Alias: home) Main Menu Public All 56
Articles = Single Article
O v Intro to Joomla (Alias: intro-to-joomia) Main Menu Public All 2512

Separator

4. Find the menu item (in this case, “Advanced Content Editing”) and click on its title:
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Site - Main Menu - Search Q Search Tools » Clear

Ordering ascending v 20 | -
s« [ Status Title Menu Home Access Language 1D

H O J — Ceanters (Alias: centers) Main Menu o Public Al 2436
— Articles » Single Arlicle

H O v — News (Alias: news) Iain Menu i Public All 2472
— Articles » Category List

£ O ] Module Workshop (Alias: module-workshop) Main Menu | ¥ Public All 2705
Aricles » Category List

H O v JEvents by Month (alias: jevents-by-month) Main Menu i Public All 2736
JEwenis - Core = View by Month = View by Month

o M v Advanced Content Editing (§ias: advanced-content-editing) Nain Menu T Public All 2755

hNES s comge e

H O o Front-End Editing (Alias: front-end-editing) Main Menu b Public All 2754
Aricles » Category List

H (] J Michelle's main {Alias: michelle-s-main) Main Menu g Public All 2764
Aricles » Single Article

L] “ 1 2

5. Look at the value for “Choose a Category *” — it will show you which category that menu item links to.

i= Menus: Edit ltem

v | Save&Close | | 4 | Save & New [l | Saveas Copy | | @ | Close

Menu Title * = Advanced Content Editing s

Dietails Category List Layouts Options Integration Link Type Page Display Metadata

Moduls Assignment

Menu ltem Type * Category List = Select
Choose a Category Advanced Content Editing | & Edit | 3 Clear
Tags Type or select some tags

6. Close the menu item

7. Go to Content > Categories

8. Click on the green circle (with a number in it) to the right of the category title to display a list of published
articles in that category:
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& Articles: Categories

©

Articles search

Featured Articles

L

Fields = B ks
Field Groups H O [+
g O [«]=
) B Q [ -

@ | Unpublish & | Archive vl | Check-in [m]

=3 Search Tools - Clear

Title

Batch ™ | Rebuild m Trash

Ordering ascending

®@ @& M Access

— Advanced Content Editing (Alias: advanced-content-editing)

cﬂo O O r

— Front-End Editing (alias: fronl-end-editing)
— Meodules Workshop Articles (Alias: modules-workshop-articles)

— Administrator Workshops (Alias: administrator-workshops)

9. Find the article that you need to edit and click on its title.

> =
QO Articles
@ Ec | v Puisn | O Unpudien | * Feaure
®©
tax L
Status  Tite
v =
v =
v =) A
v =
v - A 0
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ARTICLE EDITING
Select the article by clicking on the article title; this will bring you to the Article Edit page.

Z Aricles: Edit

= Ssave + | Save & Close =+ | Save & New [k | Saveas Copy & | Versions @ | Close

Tite * | Eddie Konczal Alias | eddie-konczal

Content Options Sample Fields Publishing Configure Edit Screen Permissions

Iy rchaw i oo .
O lshow/hide] Editor Code Preview

Format ¥ Styles v || B I | O | & & v
= |==|s% |E|ExE~aE|l=|=
E = v & B~ % B =
L
: = Keith Emerson

= Robert Fripp

= Peter Gabrial

= Chris Sguire !
i T
:Important File :

PARAGRAPHS AND LINE BREAKS
Hitting the [Enter] key at the end of a line of text will create a new paragraph, shown in the content area as a small grey
letter “P” (see the example to the left below). Note: these “Ps” will not be visible on the website itself; they are for your

reference.

Pressing the [Shift] and [Enter] keys simultaneously creates a Line Break. The next line will appear below the first

without any spacing in between (see the example to the right below).

Work with spacing:
Hello
World
Hello
This Worid
This
Is a paragraph space... Is a
Line Break...

Page



WORKING WITH LISTS
The easiest way to add a list is to first type the list items, pressing the [Enter] key after each item. Highlight the list of
items, then click the “Unordered List” button on the toolbar to format the text as a list:

1. Type a list of 2. Highlight the items and 3. Your items will appear as a
items, hitting [Enter] click on the “Ordered List” numbered list (“Ordered List”) or a
after each one: or Unordered List” button bulleted list (“Unordered List”)
1
i)
9 ~ CE ba v U
Paragraph v Styles v Rl Z|(OlA|2LiQ|Y
EEanm F IEvisvy @ - Work with lists:

Work with lists:
5 - o v .

Classes Taught: Work with lists:

Classes Taught:

Introduction to Joomia
Classes Taught:

Detailed Website Editing "
———— * Introduction to Joomia
Docman « Detailed Website Editing

Detailed Website Editing N Docman
Docman

To create contrast between the list items, select your list and select “striped-list” from the “Styles
dropdown menu (note: the change in style is not visible from Editor Mode, but will be on the website):

1. Select all of the list items
© 2. Click on “Styles”
X EBEDBEE MR Q9 |[2H 3. Select “striped-list”
Format v striped-list v & B I U A: A
E == 2 =
= e highlight_article

pquote_left
pquote_right
Classes Tau¢ md-phrasc

* Inl reg-text

e De
¢ Dc sas-responsive-tbl

Work with list

small_text

Work with lists

span5 Work with lists

» striped-list
; Classes Taught

Introduction to Joomla

span3

Detailed Website Editing

Docman
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INSERTING A VIDEO INTO YOUR ARTICLE

1. Go to https://www.youtube.com/rutgers and find a video
2. Click on the “SHARE” button under the video, and copy the link, which will look something like:

https://youtu.be/b-szT4uQs0U

3. Inthe article, enter the following code:
{youtube} [URL of video] {/youtube}

4. If you paste the video link and it appears as a hyperlink, you need to highlight the link, then click the “Unlink”
button — otherwise, the video will not appear as embedded:

Content Options Sample Fields Publishing Configure Edit Screen Permissions
(Hishow/hidel

9 # 5 B B A ¢ B E

Paragraph v Styles v | [ | B 7l | W o S0l | (B | ¥

= E E E = st | | |— || &4

= B 1} : ah:
- il ES =]t = el T (B ) (| = ||| R | |
P

P

‘More text here

e
Yot more text

ADJUSTING PARAMETERS FOR VIDEO:

You can insert “pipes” (“|” characters) after the YouTube URL, followed by numbers, to set the height and width of the
embedded video. The first number will be the width, and the second will be the height. To specify a percentage of the
web page size, enter a number followed by a percent sign. To specify a width or height in pixels, just enter the number.

For example, this code will display the video at the full width (100%) of the page, and at a height of 480 pixels:

{youtubelhttps://youtu.be/b-szT4uQs0U|100%|480{/youtube}
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ACCESSIBILITY FOR VIDEOS

Consider accessibility standards before adding videos to your website. All videos should be closed-captioned
before you add them to your website.

RUTGERS YOUTUBE CHANNEL

We recommend that you have your videos uploaded to the Rutgers YouTube channel, managed by the iTV
Studio. The studio provides closed-captioning services.

To submit a video, use the form at:
http://www.rutgers.tv/resources/youtube-upload-request-form

KALTURA

You can also upload videos to Kaltura, which is part of Canvas. Any videos uploaded to Kaltura will give you
the option to add closed captioning automatically.

Rutgers faculty or staff can request a Kaltura account. To get started with Kaltura, go to either:

e https://canvas.rutgers.edu/external-apps/kaltura/

e https://tlt.rutgers.edu/instructional-technology-tools/kaltura

NEW MEDIA CENTER - OPTIONS FOR DIY VIDEOS
Faculty who need to create a video for use in a credit-bearing course can access the Project Studio space for up to 15
hours per semester.

If the course is non—credit, or if the media is for another purpose or destination, use of the studio is charged at the
standard rates.

For more information, see:

https://tlt.rutgers.edu/new-media-center
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ADDING LINKS TO FILES

INSERTING BASIC FILE LINKS
1. Type the name of the link, highlight the text, and click on the “Insert/Edit Link” button:

AHTREE A O ¢ |2

Paragraph = Styles ¥ (k)| B I || A (Al AR
= == ||= = v =y (2 — [

I
£,
-

2. Inthe “Link” popup window, click on the “Browse” icon (see #1 below):

Link X
Link Advanced Popups
URL = =
Text Element Selection
Q, search  $¥

» [ Contacts

» [ Content

» | Menu
r [ Taos
» g Weblinks

3. Browse to the location of the file, select the file, and click Insert:

Page



File Browser

A / pdi-files / (0 folders, 10 files)

14

Folders 12 1% name -

B July 27 B

B tvedia |—L'1 Agministrative Council- 2.12.2020.2[11‘

B M.images [  Front-end-editing 07-08-2020.pdf 2

. news-images Introduction_to_Joomla_04-07-2020.pdf
~ G pdffiles 1 joomla-cam.pdf

B People @ MA_Requirements.pdf

M phocagzllery NJESL_Poster.pdf

B chotos PPM-COP_flyer.pdf

B publicdomain RU_IDguide_10.16.19.pdf

B Fuppy images A testv2pdf

B randomimages test v.pdf

I resized

Show all H

X
H Mew Folder BUpIoad 0 Help
Il Q Details

Front-end-editing_07-08-2020 o
pdf File -7

Size: 2.88 MB ©
Modified: 20/07/2020, 11:41 @
o
@

3

¥ Cancel £ Refresh

Back in the “Link” popup window, click Insert. The text will link to the file you selected.
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INSERTING ADVANCED FILE LINKS

You have more control over links to files with JCE Editor Pro’s “Insert/Edit File” button.

m v | Save &Close 4+ Save&New | | @ Cancel

Tite* | Add file link

Content Options Publishing Configure Edit Screen Permissions

(I) [
A EODE A 48 AN'C:
Paragraph v Styles vVi[sl| B || I U A A
Ex3nE == @B
= = L] 3| v =k¢

Alias

m

Select the text to

be linked, then
/ click on
the“Insert/Edit
File” button.

Settings:

File Manager
Popups

images/Class_-_Website_Admin_and_Editing.pdf

website admin and editing

Link 4 OpenWith --Not Set--

Class_-_Website_Admin_and_Editing.pdf Target Open in new window
Layout = Size  7.02MB ] Date  05/01/2017,05 &

Size Class 4 DateClass

# /(27 folders, 155 files) Newroder  @Bupoad (@) el

Folders

14 Name = O Q Details
Class_-_DOCman_11-02-2017.pdf Class_- Website Admin_an...
pdf File

Size: 7.02 MB

Modified: 05/01/2017, 09:00

# Home

Admin2017 Class - Website Admin_and_Edi....pdf

® B B

AdminBasics cockapoo-dog-breed-pictures-1.pg

banners B cockapoos.jpg

components-docman-documents.png

5

building

e 666

comprofiler css_f2.png

EditorWorkshop

@

cute-puppy2pg

eventlist

®

I )

cute-puppy12pg

3]

Show a1 %

B

& poten s

Example of File Link:

1. Select .pdf file (or upload one)
2. Enter a title for the file

3. Select Target = “Open in new
window”

4. Check “Icon” (so it will show a
.pdf icon)

5. Click Insert to add the file link

Add file link

8/ Class_-_Website_Admin_and_Editing.pdf
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WORKING WITH TABLES
Before adding a table to your website, ask yourself if the content should really be in a table. Generally speaking, tables
should only contain tabular data. As a rule, they should not be used simply for styling purposes.

EXAMPLES OF TABLES
Table — desktop view:

Work with Tables

Instructor Advisor For Location Day (Time

Dr. Who Major Student Scott MTh 10am - 11am
Dr. Seuss All Students RAB TF 2pm - 3pm
Dr. Strangelove Minor Students Physics Lecture Hall| MW 67

Tables — mobile view:

- Work with Tables
Work with Tables Phone display — -
om * without responsive S—
Advisor Style Location
Instructor Location | Day Time
For Day
Major 10am -
Dr. Who Scott MTh Time
Student 11am
A i 2pm - . .
Or.Seuss | . |RAB [TF - Phone display with
Physics responsive style;
Y linor
swangeoveStudents | °* M 77 notice the
information is
stacked vertically.
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INSERTING A TABLE

Goal: create a 4 column 4 row table for faculty advising hours

© 1. Click on the dropdown

arrow for the “Insert a
table” icon

A O DB MR

Paragraph v Styles

T
(1T}
Tl
1]
ol

T
Ecv

2. Select 4 cells across, and 4
cells down

L] Insert a table »
st Delete table

Cell »

3. Note that the bottom says
Row > “« 4X 4;;
Column

NAW

MAKING A TABLE RESPONSIVE .
1. Place cursor in any cell of table.

Tables 2. Click on the “Insert a table” icon

vanced

sas-responsive-tbl

3. Click on the “Advanced” tab.

sye 4. From the “Classes” menu, select
ouagecose “sas-responsive-tbl”

Background image

Frame

e 4. Also from the “Classes” menu,
select “table-striped”

Border color

Background color

5. Click Update

6. The table should now span the
width of your article. It will adjust
its size to accommodate various

. . . . browser sizes.
Possible Issues with Tables in Responsive Mode:

When making the table responsive, make sure that on the Tables — General tab, there are no values set for
width and height. If there are, delete them; these values can prevent the table from dynamically resizing itself.

e When working with cells, make sure there are no values set for width and height on the General tab for the
Table Cell Properties.
Page
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MODIFYING A TABLE
Adding a new column to the table:
e C(lickin any cell in the table
e Click on either the “Insert Column Before” (#1 below) or the “Insert Column After” icon (#2 below)

= T RTo T ek T Tt TR it ety ot e i T Tt TR T
s et = el e e e = el e e e e i
AEET SERn AT = SESheERRT SEAnET T = SEShRERET SEAnET T et e

== Ol e e T e P e T e T TP U e T R ek
=== T e e etk et | Tt e =SS anT o e L e e
s et = el e e e = el e e e e i
AEET SERn AT = SESheERRT SEAnET T = SEShRERET SEAnET T et e
=T R e e T PP e e Tt B T TP T e e e Rl e ek e

Adding a new row to the end of the table
Go to the last cell of the table and you hit [TAB] key; it will add an additional row to the table.

Adding content to table:
e Asyou enter content into cells, use the [Tab] key or arrows to move to the next cell. Do not type [Enter], as this
will add unwanted paragraph tags to your table.
e Inthe top row of your table, enter the column headings: “Instructor,” “Advisor For”, “Location,” “Day,” and
“Time”
e Enter sample text in the remaining cells.

» 7 LD I W %2

V=B
Categd
Format v sas-responsivY 4 B I U A: A 4
EE = E E =M M) == ]
E e b =y % Featurd
Instructor Advisor For Location Day Time

Dr. Who Major Student Scott MTh 10am - 11am Access
Dr. Seuss All Students RAB TF 2pm - 3pm Publi
Dr. Strangelove ‘Minor Students Physics Lecture Hall MW 67 Langud

Al

Tags

18
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Changing Cells to Headers

1. Place the cursorin any cell in the top row of your table
2. Click on the “Table Cell Properties” icon:

e A HEEENRAS

Format v Styles v [ B I (| T | & | & v

= | E(=E|E(E = == vEl—E

E sy 4 BrE E|lE|lE B B\ EH B E O % B
=

T

Change Cell Type to “Header” (see #1 below)

Change “Scope” to “Column” (see #2 below)

Change the lower left dropdown to “Update all cells in row” (see #3 below)
Click Update (see #4 below)

o v kuw

Table cell properties X

zeneral Advanced

dk

Alignment --Mot Set-- celltype 1 Header ¥

ar

Vertical alignment --Mot Set-- Scope 2 Column v

Width Height

3 4

|Update allcellsinrow =
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Deleting a Row
1. Place the cursorin any cell in the row you want to delete
2. Click the “Delete Row” icon:

5] X BB B MRS eR

Format v Styles v & B || ]l |f e v
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Removing Paragraph (<p>) tags
If accidentally you hit the [Enter] key in a cell, you may notice that the table rows end up being different heights. Look
for cells containing the “P” marker (for paragraph). Then you can remove the paragraph tag as follows:

1. Place cursorin any cell containing a “P” (see #1 below)
2. Click on ‘Paragraph’ dropdown (see #2 below)
3. Select ‘Paragraph’ to remove the check mark (see #3 below)
4. Repeat until there are no “P” markers in the table
D & @ BB A2 € 2

Paragraph 2 w [Styles v | | B I O | a | & A |
J Paragraph 3 vl = | — |

Heading 2 BB e E EE B B O w2

Heading 3

Heading 4
Definition Description

Definition Term

Figure
'graduate [

Blockquote dents
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Custom FIELDS

Custom Fields allow you to standardize the layout of your articles by entering content into fields, similar to those found

in a form. They are often used when displaying a list of articles that share a common layout, with repeating fields such

as email address, phone number, office, etc. If you would like to use custom fields in your articles, please submit a work

order.

Once we add the fields, you can update the content by moving the appropriate text from the “Content” tab to the
custom fields tab (the tab name will vary based on the website and category). We can then change the menu item to

display the custom fields for each article.

Sample Category Blog of articles with custom fields:

https://www.sas.rutgers.edu/cms/deptdemo/people/faculty

Faculty

Firstname A Lastname
PROFESSOR |

Ph.D. Universtiy of New Jersey

mailto:email @email.edu

Office: Building Hall, 123

(732) 123-4567

Research Interests: list of research interests

Read more: Lastname, Firstname A

Firstname B Lastname
PROFESSOR

Ph.D. Rutgers University

mailto:email @email.edu

Office: George Street

(732) 123-4567

Research Interests: list of research interests

Read more: Lastname, Firstname B

Firstname C Lastname
DEPARTMENT CHAIR

Ph.D. NYU

mailto:email @email.edu

Office: College Ave

(732) 234-5555

Research Interests: list of research interests

In the above example, each faculty member’s information is entered into custom fields for title, degree, email address,

office, phone number, and research interests
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ADDING CONTENT TO CUSTOM FIELDS

When editing an article in a category that has custom fields assigned to it, click on the new tab that appears in your
article editor. In the Training website, case, the tab is titled “Sample fields.”

Tile* | Eddie Konczal

Content Options Sample Fields Publishing Configure Edit Screen Permissions

Portrait Image > Select | L | K

Fomatied Mame
Position

Email Address

You can then complete the fields in the same way you would complete a form.

SLIDERS

Sliders (sometimes referred to as “accordions”) create title links that hide text within an article. The text appears when

you click the title. They are appropriate for pages such as FAQs where condensing the text makes the page easier to
scroll through.

To add sliders to your content, your site must have the “Sliders” plugin installed and enabled.
Sample code:

{slider Question 1}

Answer to question 1

{slider Question 2}

Answer to question 2

{/sliders}
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Example of sliders:

Question 1

Answer to question 1

Question 2

LOGOUT FROM JOOMLA!
Click the profile icon to the upper right of your Joomla! administrator page, then click “Logout”:

CMS Sandbox|... &t |2

K/’ 2 Eddie Konczal

Edit Account

Archive
©  rep & upuons
FUTURE WORKSHOPS
Please visit:

e https://sas-it.rutgers.edu/itservices/web-development-and-support/joomla-workshops-training/
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